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Word 8.0 Form 530 Document Template 

The Word 8.0 template for filling in Form 530 are electronic versions of Form 530. The template allows 
authors to fill in the form via a series of screens and entry fields. 

Installation 

NOTE: The Form 530 template can be used with Word 8.0 or higher on any of the following operating 
systems: 

• Windows 95 

• Windows 98 

• Windows NT 4.0 

Installing to Word 8.0 
Before using Form 530 to author forms, it is important that the template to create the electronic document 
be installed on your local hard drive. Follow the instructions below to install the template to your system. 

1. Insert the diskette into your diskette drive. 
2. Open your Windows Explorer. 
3. View the contents of the diskette by choosing either the A:\ or B:\ drive. 
4. Copy the file, 530_v8.dot (the template), from the A:\ or B:\ drive to the TEMPLATES directory 

contained in your MSOFFICE directory. (On standard systems, this will be the 
C:\MSOFFICE\TEMPLATES directory.) 

B-_J Msoffice 
B-_J Clipart 

B-v_J Excel 
| " 1 Ms-bttns 

H-__| Powerpnt 

;--_j Setup 

 :_J iPHfflf 
H-_l Winword 

Once the template has been copied to your hard drive, you may begin to create electronic forms. 
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Getting Started 

Starting a New Form 
To author an UNCLASSIFIED Form 530, the template named Form 530 should be chosen from the File | 
New menu (Figure 1) in Word. Select the template name and click on OK or press ENTER to start a new 
document. 

Xemplate: 

Agenda Wizard 
Award Wizard 
Brochurl 
Calendar Wizard 
Directr 1 
Fax Wizard 
Faxcovrl 
Faxcovr2 
Form530 

OK 

Cancel 

Summary. 

Help 

1 Invoice 

-New  
(•). Document 

O Template 

-Description""-  :— - 

REPORT DOCUMENTATION PAGE 

Figure I. New Document Window 

The Nonprint Product Documentation Page (Form 530) will appear on your screen after choosing OK from 
the "New" window. Next, a series of screens, or windows will appear. 

Form 530 is used to catalogue information about your nonprint product. The electronic Form 530 template 
will provide you with a method for filling out the form automatically. 

The first screen provides you with a set of instructions pertaining to filling out the form (Figure 2). Choose 
OK to proceed with filling out the form. 

SF 530: NONPRINT PRODUCT DOCUMENTATION PAGE 

GENERAL INSTRUCTIONS FOR COMPLETING SF530 

The Nonprint Product Documentation Page is used in 

•announcing and cataloging nonprint products. It is important 

that this information be consistent with the rest of the report, 

f particularly the cover and title page. Instructions for filling 

i in each block of the form follow. 

OK 
 ■ ■"••" 

Cancel 

Figure 2. Nonprint Product Documentation Page Instructions 
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Entering Information into the Form 

IMPORTANT! 

If you click CANCEL in ANY of the dialogs provided for entering information into the form, you will be 
provided with a message asking if you are sure you want to cancel (Figure 3). 

CANCEL MESSAGE 

-Are you sure you want to CANCEL?——— 

CANCEL will close the document without 

saving any information that has been input. 

If you want to save information, you must 

first complete the form. 

Continue CANCEL? 

No Yes 

Figure 3. Cancel Message 

If you choose YES from this message box, the Nonprint Product Documentation Page will close 
WITHOUT saving information you have entered, and WITHOUT saving the document. Once you finish 
filling out the form, you will be able to edit information you have entered and save the form to a diskette or 
another drive. 
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BLOCK 1: Type of Product 
The first block you will need to fill out will provide information about the product type (Figure 4). 
Depending upon which selection is chosen, the user will only view and enter information into those dialogs 
applicable to the specified nonprint product: 

• DISKS (Floppy or CD-ROM): Blocks 1-31, 46-48 

• VIDEOS: Blocks 1, 3, 11-31, 36-37, 40-41, 46-48 

• MAGNETIC TAPES (Reels or Cartridges): Blocks 1-4,11-39, 46-48 

• MULTIMEDIA CD-ROMS: Blocks 1-31, 36, 42-48 

This information will fill in BLOCK 1 on Form 530. Select the radio button of the type of nonprint product 
or enter "Other" and type the nonprint product type into the entry field. This information will fill in BLOCK 
1 on the Nonprint Product Documentation Page. Choose OK to continue filling out the form. 

BLOCK 1:   TYPE OF PRODUCT 

Block 1. Type of Product-^—--—-———— : ——-—  

Depending on the nonprint product selected in Block 1, only blocks applicable 

to that product will be displayed for completion. For example, if Magnetic Tape 

is selected, only blocks 1,3» 11 -39, and 46-48 display for entry. 

Select the type of nonprint product, such as CD-ROM, Computer (Floppy) Disk, 

Magnetic Tape, Videocassette, or Other. If Other is selected, enter the 

nonprint product type. 

:C?!roflOMj 

f\ Computer (Floppy) Disk 

C-'- Magnetic Tape 

O Videocassette 

C, Other   I 

OK Cancel 

Figure 4. Block 1 Type of Product 

Click the OK button to continue filling out the form. 
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BLOCK 2: Operating System/Version 
The second block you may need to fill out will provide information about the operating system/version of 
the nonprint product, such as "MS-DOS" or "Windows" (Figure 5). This information will fill in BLOCK 2 
on the Nonprint Product Documentation Page. Enter the operating system/version in the entry field. 

BLOCK 2:  OPERATING SYSTEMWERSION 

Block 2. Operating System/Version -——————- 

Identify the operating system software used 
to access the nonprint product 

Include version, if possible {e.g. MS-DOS, 

Unix, OS/2, Mac, Windows, Magnetic Tape]. 

OK Cancel 

Figure 5. Block 2 Operating System/Version 

Click the OK button to continue filling out the form. 

BLOCK 3: New Product or Replacement 
You will be required to select either "New" or "Replacement" into BLOCK 3 (Figure 6). "Replacement" is 
the correct selection to choose if the nonprint product is a previous submittal to DTIC and the current form 
submission replaces a previous form submission. 

BLOCK 3:   NEW PRODUCT OR REPLACEMENT 

Block 3. New Product or Replacement——  

Select 'new' or 'replacement' (if nonprint product has 

previously been submitted to DTIC and replaces 

a previous report). 

i* iNewj 

C Replacement 

OK Cancel 

Figure 6. Block 3 New Product or Replacement 

Click the OK button to continue filling in the form. 
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BLOCK 4: Type of File 
Select "Software", "Text", "Database", or any combination of the three as applicable to the nonprint 
product in the BLOCK 4 window (Figure 7). 

BLOCK 4:  TYPE OF FILE 

-Block 4. Type of File——~—■—-— ——:——————— 

Click on the type of file for the nonprint item being submitted. 

If product contains both software (e.g. a program) and a 

database, for example, click on both the software and database 

entries. 

F" (Software] 
HText " 
T" Database 

OK Cancel 

Figure 7. Block 4 Type of File 

Click OK to continue filling in the form. 

BLOCK 5: Language/Utility Program 
Enter the language or utility product, such as "MS Excel" or "Adobe Acrobat", of the nonprint product into 
BLOCK 5 (Figure 8). 

BLOCK 5:   LANGUAGE/UTILITY PROGRAM 

Block 5.  Language/Utility Program    —       — 

Enter the name of the utility program or the database 

language used to create the nonprint product, for 

example, MS Excel, Adobe Acrobat, Apple Quicklime. 

Identify release or version if possible. 

OKI Cancel 

Figure 8. Block 5 Language/Utility Program 

Click OK to continue entering information. 
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BLOCK 6: Number of Files or Products 
Enter in the number of files and the number of nonprint products, such as "1/1" for one videotape into 
BLOCK 6 (Figure 9). This is a MANDATORY entry. 

BLOCK G:  NUMBER OF FILES OR PRODUCTS 

■Block G. Number of Files/Number of Products———  

Identify the total number of files and the total number of 

nonprint products being submitted separated by a slash (/). 

For example, one program on one videotape would be 1 /I; 

a total of G4 files on two disks would be 64/2. 

OK Cancel 

Figure 9. Block 6 Number of Files or Products 

Click OK to continue entering information. 

BLOCK 7: Character Set 
Select the nonprint product's character set, such as "ASCII" or "Binary", or enter "Other" and type the 
applicable character set into the entry field in BLOCK 7 (Figure 10). 

BLOCK 7:   CHARACTER SET 

Block 7. Character Set- 

Select the applicable character set, if known. 

© iBinary] 

O ASCII 

O Other! 

| OK Cancel 

Figure 10. Block 7 Character Set 

Click OK to continue entering information. 
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BLOCK 8: Disk Capacity 
Select the disk capacity or enter "Other" and type the disk capacity of the nonprint product into the entry 
field into BLOCK 8 (Figure 11). 

BLOCK 8:   DISK CAPACITY 

Block 8. D isk Capacity  - 

Select the capacity of the disks being submitted. 

If Other is selected, enter the disk capacity. 

r 1.44MB 

T 650 MB  

C Other   j  

OK Cancel 

Figure 11. Block 8 Disk Capacity 

Click OK to continue entering information. 

BLOCK 9: Compatibility 
Select the computer compatibility or enter "Other" and type the compatibility of the nonprint product into 
the entry field into BLOCK 9 (Figure 12). 

BLOCK 9:   COMPATIBILITY 

Block 9.  Compatibility 

Select the machine with which the nonprint 

product is compatible. 

If Other is selected, enter the compatibility type. 

O PC 

O Macintosh 
O UNIX 

.   @ ;Other] 

OK Cancel 

Figure 12. Block 9 Compatibility 

Click OK to continue entering information. 
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BLOCK 10: Disk Size 
Select the size of the disk being submitted or enter "Other" and type the disk size of the nonprint product 
into the entry field into BLOCK 10 (Figure 13). 

BLOCK 10:   DISK SIZE 

Block 10. DiskSize  

Select the size of the disk(s) being submitted. 

If Other is selected, enter the disk size. 

■■■■■ C-51/4 : 

n CD-ROM 

C Other 

OK Cancel 

Figure 13. Block 10 Disk Size 

Click OK to continue entering information. 

BLOCK 11: Title 
In this block, you will need to enter the title of the nonprint product (Figure 14). 

NOTE: You must enter the title of the nonprint product in this window. If there is not a title entry, an error 
message will appear requesting the entry of a title, as it is REQUIRED.  

BLOCK 11.   TITLE 

Block 11. Title :  

Enter the title used to most specifically identify 
the nonprint product being submitted. 
Include volume number or version, if applicable. 
For example, EARTHQUAKE PREDICTION SOFTWARE ver. 1.2. 

OK Cancel 

Figure 14. Block 11 Title 

Click the OK button to continue filling in the form. 

Word 8.0 Form 530 Document Templates 



Title Classification 
A classification of title dialog appears after the Title block. Select the title classification of the nonprint 
product into this block (Figure 15). A "U", "C", or "S" appears after the title entry in Block 11 according to 
the title classification selection. 

CLASSIFICATION OF TITLE 

Classification of Title  — — 

Select the security classification level 

for the title in Block 11. 

(* Unclassified 

f" Confidential 

f* Secret 

[     OK I Cancel 

Figure 15. Classification of Title 

Click OK to continue entering information. 
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BLOCK 12: Performing Organization Name(s) and Address(es) 
Provide information about the Performing Organization in BLOCK 12 (Figure 16). Enter in the name of the 
organization and the organization's full address in this screen. 

If you will be re-using this address information in Block 16 ("Sponsoring Organization Name(s) and 
Address(es)."), or if you will be re-using this information on the same system to complete further forms, you 

Set Default I). This button will save the address for use in should use the SET DEFAULT button ( 
further dialogs or further electronic forms. 

If you have already created electronic forms with the Form 530 template and have saved addresses, you may 

use the USE DEFAULT button (l 
Use Default 1) to retrieve a previously saved address into the text boxes 

in Block 12. If there is not a previously saved address, a message box will appear, informing you that there 
is no default. 

NOTE: It is mandatory that there is a Performing Organization name entry. If not, an error message 
appears and you will not be able to continue without first entering the name of the organization. 

BLOCK 12:  PERFORMING ORGANIZATION 

B lock 12. Performing 0 rganization N ame(s) and Address(es). —— 

Enter the name and address of the organization responsible for producing 

the nonprint item being submitted. Use the SET DEFAULT button 

to save an address for re-use in any window that requires an address 

{block 16). Use the USE DEFAULT button to retrieve a previously saved 

address into the text fields below. Once you set or retrieve a default, 

press the OK button to insert the address into the document. Default 

address information is saved across documents and can be re-used 

for multiple electronic forms. To change the default settings to a new 

address, enter the address in the text boxes and click on the SET 

DEFAULT button; the old default address will be overwritten. 

Organization Name and Address: 

City: 

Zip: 

State: 

Set Default  1        Use Default    | OK Cancel 

Figure 16. Block 12 Performing Organization 

When you press OK from BLOCK 12, a prompt for further entry of further names and addresses of 
Performing Organizations appears. If you choose YES from the message box (Figure 17), you will be 
provided with the BLOCK 12 screen (Figure 16) a second time; otherwise, you will move on to BLOCK 13 
(Figure 18). 

Word 8.0 Form 530 Document Templates 11 



Additional Addresses 

Is there more than one performing 

organization for this project? If so, 

please press YES to enter further 

performing organization names and 

addresses. 

YES NO 

Figure 17. Further Performing Organizations Data Entry 

BLOCK 13: Performing Report Number(s) 
Enter the report number(s) assigned by the Performing Organization into BLOCK 13 (Figure 18). 

BLOCK 13:  PERFORMING REPORT NUMBERS 

r Block 13. Performing Organization Report Number(s).- 

Enter the unique alphanumeric report number(s) 

assigned by the organization performing the report. 

Example: BRL-1234;AFWL-TR-85-4017-Vol-21 -PT-2 

OK Cancel 

Figure 18. Block 13 Performing Organization Report Numbers 

Click on the OK button to continue filling in the form. 

BLOCK 14: Contract Number 
Enter the contract number of the nonprint product into the entry field in BLOCK 14 (Figure 19). 

BLOCK 14:   CONTRACT NUMBER 

-Block 14. Contract Number.-—————— 

Enter the contract number or grant number as it 

appears in the nonprint product. 

Example: F3G51-8G-C5169 

NO; rd-9938 

;OK Cancel 

Figure 19. Block 14 Contract Number 

Click OK to continue entering information. 
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BLOCK 15: Program Element Number 
Enter the program element number of the nonprint product into the entry field in BLOCK 15 (Figure 20). 

BLOCK 15:  PROGRAM ELEMENT NUMBER 

Block 15. Program Element Number.——— 

Enter program element number as it appears 

in the nonprint product. 

Example: 61101A 

OK Cancel 

Figure 20. Block 15 Program Element Number 

Click OK to continue entering information. 

BLOCK 16: Sponsoring/Monitoring Organization Name(s) and Address(es) 
Enter information about the Sponsoring/Monitoring Organization into BLOCK 16 (Figure 21). Enter in the 
name of the organization and the organization's full address in this screen. 

If you want to use an address that was previously saved in either another electronic form creation, or that 

Use Default ). If there is not a previously was saved in Block 16, choose the USE DEFAULT button (I 
saved address, a message box will appear, informing you that there is no default. Otherwise, previously 
saved address information appears in the text fields in Block 16. 

If you want to overwrite a previously saved address, type in the new address and choose the SET 

nrc,IirT,   „     i   Set Default i DEFAULT button (|_—,,,-r^q.——j) _ 

NOTE: It is mandatory that there is a Sponsoring/Monitoring Organization name entry. If not, an error 
message appears and you will not be able to continue without first entering the name of the organization. 
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BLOCK 16:   SPONSORING/MONITORING ORGANIZATION 

Block 1G. Sponsoring/Monitoring Organization Name(s) and Address(es).— 

Enter the name and address of the agency responsible for administering 

or monitoring the project, contract, or grant under which the nonprint product 

was being submitted was produced. Use the SET DEFAULT button to save 

an address for re-use in any window that requires an address (block 12). 

Use the USE DEFAULT button to retrieve a previously saved address into 

the text fields below. Once you set or retrieve a default, press the 

OK button to insert the address into the document. Default address 

information is saved across documents and can be re-used for multiple 
electronic forms. To change (he default settings to a new address, 

enter the address in the text boxes and click on the SET DEFAULT button; 

the old default address will be overwritten. 

Organization Name and Address: 

I 

City: State:  ] 

|        OK       | 

Zip:    J 

Set Default   J        Use Default Cancel    | 

Figure 21. Block 16 Sponsoring/Monitoring Organization 

When you press OK from BLOCK 16, a prompt for further names and addresses of Sponsoring/Monitoring 
Organizations appears. If you choose YES from the message box (Figure 22), you will be provided with the 
BLOCK 16 screen (Figure 21) a second time; otherwise, you will move on to BLOCK 17 (Figure 23). 

Additional Addresses 

Is there more than one sponsoring/ 

monitoring organization for this 

project?  If so, please press YES to 

enter further sponsoring/monitoring 

organization names and addresses. 

CSS! NO 

Figure 22. Further Sponsoring/Monitoring Organization Addresses Data Entry 
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BLOCK 17: Sponsor/Monitor's Acronym(s) 
Enter any acronym (s) assigned by the Sponsoring/Monitoring Organization into BLOCK 17 (Figure 23). 

BLOCK 17: SPONSOR/MONITOR ACRONYM 

rBlock 17, Spohsor7Monitor'sAcronym(s) 

J Enter any acronyms that pertain to the Sponsor/Monitor, if applicable. 
Separate acronyms with commas (,). Example: BRLARDEC, NADC. 

OK Cancel 

Figure 23. Block 17 Sponsor/Monitor's Acronyms 

Click on the OK button to continue filling in the form. 

BLOCK 18: Sponsor/Monitor Number(s) 
Enter the sponsor/monitor number(s) assigned by the Sponsoring/Monitoring Organization into BLOCK 18 
(Figure 24). 

BLOCK 18:  SPONSOR/MONITOR NUMBER(S) 

-Block 18. Sponsor/Monitor's Numberfs).  

Enter the nonprint product numberfs) as assigned by the 

sponsoring/monitoring agency, if available. Example: TR829;-215 

OK Cancel 

Figure 24. Block 18 Sponsor/Monitor Numbers 

Click on the OK button to continue filling in the form. 

BLOCK 19: Project Number 
Enter the project number as it appears on the nonprint product into BLOCK 19 (Figure 25). 

BLOCK 19:   PROJECT NUMBER 

-Block 19. Project Number.  - 

Enter the project number as it appears on the 

nonprint product. 

Example: 1F6G5702D1257; ILIR; MR04101 

OK Cancel 

Figure 25. Block 19 Project Number 

Click on the OK button to continue filling in the form. 
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BLOCK 20: Task Number 
Enter the task number as it appears on the nonprint product into BLOCK 20 (Figure 26). 

BLOCK 20:  TASK NUMBER 

pBIock 20. Task Number.  

Enter the task number as it appears on the 

nonprint product. 

1 Example: 05; RF0330201; T4112 

OK Cancel 

Figure 26. Block 20 Task Number 

Click on the OK button to continue filling in the form. 

BLOCK 21: Work Unit Number 
Enter the work unit number as it appears on the nonprint product into BLOCK 21 (Figure 27). 

BLOCK 21: WORK UNIT NUMBER 

-Block 21. Work Unit Number.-^—-r--—-—— 

Enter the work unit number as it appears on the 

nonprint product 

Example: 001;AFAPL30480105 

OK Cancel 

Figure 27. Block 21 Work Unit Number 

Click on the OK button to continue filling in the form. 
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BLOCK 22: Date 
Enter the publication date of the nonprint product by entering a day in numerical format (1-31), selecting a 
month from the drop-down list, and entering a four-digit year in the "Year" field into BLOCK 22 (Figure 
28). 

NOTE: You will be required to enter at least the Year, and it MUST be in four digits or an error message 
will appear and will not let you proceed until a year is entered.  

BLOCK 22:   DATE 

Block 22. Date 

Enter full publication date including day and month, if available. 
Must cite at least the year and be Year 2000 compliant, 
eg. February 12,1999- 

Month: ' 
Day: 

Year: 

OK Cancel 

Figure 28. Block 22 Date 

Choose OK to continue filling out the form. 

Block 23: Classification of Product 
Select the classification of the nonprint product into BLOCK 23 (Figure 29). 

BLOCK 23.   CLASSIFICATION OF PRODUCT 

rBlock 23. Classification of Product-—  

Choose a classification of this nonprint product. 

This is a REQUIRED entry. 

(*. j Unclassified! 

^Confidential 

<*** Secret 

OK Cancel 

Figure 29. Block 23 Classification of Product 

Click OK to continue entering information. 
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BLOCK 24: Security Classification Authority 
Enter the security classification authority for the nonprint product into BLOCK 24 (Figure 30). This is a 
REQUIRED entry. 

BLOCK 24.   SECURITY CLASSIFICATION AUTHORITY 

Block 24. Security Classification Authority— 

Enter the security classification authority for 

the nonprint product. 

This is a REQUIRED entry. 

iOKi J Cancel 

Figure 30. Block 24 Security Classification Authority 

Click on the OK button to continue filling in the form. 

BLOCK 25: Declassification/Downgrade Schedule 
Enter the declassification/downgrade schedule of the nonprint product into BLOCK 25 (Figure 31). 

BLOCK 25.   DECLASSIFICATION / DOWNGRADE SCHEDULE 

Block 25. Declassification / Downgrade Schedule  

Enter the declassification/downgrade schedule information 

for the nonprint product. 

This is a REQUIRED entry. 

OKi Cancel 

Figure 31. Block 25 Declassification/Downgrade Schedule 

Click on the OK button to continue filling in the form. 
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BLOCK 26: Distribution/Availability Statement 
Enter specific Distribution and Availability codes into BLOCK 26 (Figure 32). This information will appear 
on the Nonprint Product Documentation Page based on which item you choose from the list of available 
codes. 

The UNCLASSIFIED Form 530 template provides seven available distribution codes. When you choose a 
code, it will appear in the edit box above the list of codes. To change your choice, click on a different code. 

After selecting a code, press OK to continue filling in the form. 

BLOCK 26.  DISTRIBUTION/AVAILABILITY STATEMENT 

Block 26. DistributionÄvailability Statement.-   -  ~- -    ~ : "— 

Use agency-mandated availability statements to indicate the public availability or distribution limitations of 
the report. If additional lirntationsAestrictions or special markings are indicated, follow agency authorization 
procedures. Include copyright information. This is a REQUIRED field. 

Example: RD/FRD, PROPIN, I TAR, etc. 

Distribution Statement: 

A Approved for public release; distribution is unlimited. £j 
B Distribution authorized to U.S. Qov't. agencies only; (reason and date). Other requests for this document shall be referr 
C Distribution authorized to U.S. Gov't. agencies and their contractors; (reason and date). Other requests for this docum« 
D Distribution authorized to DoD and U.S. DoD contractors only; (reason and date). Other requests shall be referred to (c; -: 

E Distribution authorized to DoD only; (reason and date). Other requests shall be referred to (controlling DoD office). 
F Further dissemination only as directed by (controlling DoD office and date) or higher DoD authority. y 
X Distribution authorized to U.S. Gov't. agencies and private individuals of enterprises eligible to obtain export-controlled tjj 

OK I Cancel I 

Figure 32. Block 26 Distribution/Availability Statement 

Supplementary Distribution Code Information 
If you choose any distribution code other than Distribution Code A, you will need to input further 
information about the date of determination of the Distribution Code, and the Controlling DoD office. In 
several cases (Distribution Codes B through E), you will also be required to choose a reason for the 
Distribution Code. Enter this supplementary distribution information through a window similar to that 
shown in Figure 33. 
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Distribution Reason, Date, and Office 

Choose the appropiiate reason for the distribution : 

Foreian Government Info 
Proprietary Info 
Critical Technology 
Test and Evaluation 
Contractor Performance Evaluation 
Premature Dissemination 
Administrative/Operational Use d 
Enter the date of determination: 

Month: Jan Year: 

Insert the name of the Controlling DoD Office 

OK Cancel 

Figure 33. Supplementary Distribution Code information. 

NOTE: It is mandatory that you enter ALL information as requested in the Supplementary Distribution 
Code windows. The year entered must be a four-digit year. Any incomplete information or incorrect dates 
will cause an error message to display.  

Pressing OK will allow you to continue to enter information into the form. 

BLOCK 27: Abstract Message 
You will enter the abstract information into Form 530 after completed all other requested fields. However, 
to inform you of this, after the screen for BLOCK 26, a message screen will appear. This message screen 
informs you that the abstract of the document will be entered later (Figure 34). 

BLOCK 27:  ABSTRACT 

Block 27. Abstract. 

Once all other information has been added into Form 530, you will be 
returned to the document to enter an abstract of the report which should 
which should be a brief (maximum 200 words) factual summary of the most 
significant information contained in the nonprint product being submitted. 

i    : OK 

Figure 34. Block 27 Abstract Message 

Click the OK button to continue filling in the form. 
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Block 28: Classification of Abstract 
Select the abstract classification of the nonprint product into BLOCK 28 (Figure 35). 

BLOCK 28:  CLASSIFICATION OF ABSTRACT 

rBlock 28. Classification of Abstract————— 

Select the classification level for the abstract 

inBlock 27. 

t* Unclassified 

f" Confidential 

f" Secret 

i      0K     1 nn'iiiiiiniiiiimniiiiiw 
Cancel 

Figure 35. Block 28 Classification of Abstract 

Click OK to continue entering information. 

BLOCK 29: Limitation of Abstract 
Enter the limitations of the Abstract in the BLOCK 29 screen (Figure 36). 

BLOCK 29.   LIMITATION OF ABSTRACT 

Block 29.  Limitation of Abstract- 

Choose a distribution limitation for the abstract. 
This is a REQUIRED entry. 

©jUncjaMWj^ 

O Same As Report 

OK Cancel 

Figure 36. Block 29 Limitation of Abstract 

Press OK to continue filling in the form. 
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BLOCK 30: Subject Terms 
Type in any identifying terms or phrases, which may be used for indexing of the nonprint product (Figure 
37). Separate terms and phrases with a semicolon (;). You may type up to 255 characters in BLOCK 30. 

BLOCK 30. SUBJECT TERMS 

Block 30.  Subject Terms. 

Enter keywords or phrases identifying major subjects in the 
report. Separate key words and phrases with semicolons (;). 
Only UNCLASSIFIED terms should be entered on this form. 

OK Cancel 

Figure 3 7. Block 30 Subject Terms 

Press OK to continue filling in the document. 

Block 30a: Classification of Subject Terms 
Select the subject terms classification from the description in BLOCK 30 of the nonprint product into 
BLOCK 30a (Figure 38). 

BLOCK 30a:   CLASSIFICATION OF SUBJECT TERMS  S3 

Block 30a. Classification of Subject Terms— 

Select the security classification level for the 

subject terms in Block 30. 

<•" Unclassified 

f" Confidential 

f" Secret 

OK Cancel 

Figure 38. Block 30a Classification of Subject Terms 

Click OK to continue entering information. 
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Block 31: Required Peripherals 
Enter any equipment not listed elsewhere needed to access the nonprint product into BLOCK 31 (Figure 
39). 

BLOCK 31: REQUIRED PERIPHERALS 

-Block 31. Required Peripherals—————— 

List any equipment not listed elsewhere or which 

is not obviously required needed to access 

the nonprint product (e.g. color printer, scanner). 

OK Cancel 

Figure 39. Block 31 Required Peripherals 

Click on the OK button to continue filling in the form. 

Block 32: Number of Physical Records 
Enter the number of physical records (blocks) in the nonprint product into BLOCK 32 (Figure 40). The 
utility programs, which copy physical records without regard to the logical structure of the item, usually 
provide this number. Labels are not included in this count. 

BLOCK 32: NUMBER OF PHYSICAL RECORDS 

Block 32. Number of Physical Records^ 

Enter the number of physical records (blocks) in the nonprint product 

being submitted. This number is usually supplied by the utility programs 

which copy physical records without regard to the logical structure of 

the item. Labels are not included in this count. 

OK Cancel 

Figure 40. Block 32 Number of Physical Records 

Click on the OK button to continue filling in the form. 
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Block 33: Number of Logical Records 
Enter the number of logical records in the nonprint product into BLOCK 33 (Figure 41). The program that 
created the files usually provides this number. Labels are not included in this count. 

BLOCK 33:  NUMBER OF LOGICAL RECORDS 

Block 33. Number of Logical Records  

Enter the number of logical records in the nonprint product 

being submitted. This number is usually supplied by the program 

which created the files. Labels are not included in this count. 

OK Cancel 

Figure 41. Block 33 Number of Logical Records 

Click on the OK button to continue filling in the form. 

Block 34: Number of Tracks 
Enter the number of tracks in the nonprint product into BLOCK 34 (Figure 42). 

BLOCK 34:   NUMBER OF TRACKS 

-Block 34. Number of Tracks  

Enter the number of tracks in the nonprint product being submitted. 

OK Cancel 

Figure 42. Block 34 Number of Tracks 

Click on the OK button to continue filling in the form. 
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BLOCK 35: Record Type 
Select the type of record being submitted or enter "Other" and type the record type of the nonprint product 
into the entry field on BLOCK 35 (Figure 43). 

BLOCK 35:   RECORD TYPE 

Block 35. Record Type    

Select the type of record of the nonprint item 

being submitted. If Other is selected, 

enter the Record Type. 

^iFiiäd Length! 

■ -■ -OoSwl !! 

OK Cancel 

Figure 43. Block 35 Record Type 

Click OK to continue entering information. 

Block 36: Color 
Enter the color, such as Black and White, of the nonprint product into BLOCK 36 (Figure 44). 

BLOCK 3G:  COLOR 

-Block 36. Color  

Enter the color of the nonprint item being submitted, 

which is applicable to videotape or multimedia. 

(e.g. Black and White, Color, or Mixed (SVGA, etc.)) 

OK Cancel 

Figure 44. Block 36 Color 

Click on the OK button to continue filling in the form. 
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Block 37: Recording System 
Enter the type of recording format, such as VHS, of the nonprint product into BLOCK 37 (Figure 45). 

BLOCK 37:  RECORDING SYSTEM 

Block 37. Recording System—  

Enter the type of recording format (e.g. VHS, BETA, etc.). 

OK Cancel 

Figure 45. Block 3 7 Recording System 

Click on the OK button to continue filling in the form. 

Block 38: Recording Density 
Enter the density, such as 1600, of the nonprint product into BLOCK 38 (Figure 46). 

BLOCK 38:   RECORDING DENSITY 

Block 38. Recording Density  

Enter the density as applicable (e.g, for magnetic tapes, 

enter bits recorded per inch (200,1600,6250 bpi, etc.). 

OK Cancel 

Figure 46. Block 38 Recording Density 

Click on the OK button to continue filling in the form. 

Block 39: Parity 
Select the parity of the nonprint product into BLOCK 39 (Figure 47). 

BLOCK 39:   PARITY 

Block 39. Parity -—r -  

Select either odd or even parity. 

C Even 

r odd 
■fflNone! 

OK Cancel 

Figure 47. Block 39 Parity 

Click OK to continue entering information. 
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Block 40: Playtime 
Enter the playing time in the 00:02:40:13 format of the nonprint product into BLOCK 40 (Figure 48). 

BLOCK 40:  PLAYTIME 

•Block 40, Playtime1——— —--— ——— 

Indicate the playtime of the nonprint media in 

in the 00:02:40:13 format (e.g. for 2 hrs., 

40 min., 13 sec.) 

OK Cancel 

Figure 48. Block 40 Playtime 

Click on the OK button to continue filling in the form. 

Block 41: Playback Speed 
Enter the playback speed, if known, of the nonprint product into BLOCK 41 (Figure 49). 

BLOCK 41:  PLAYBACK SPEED 

Block 41.  Playback Speed—  

Indicate the playback speed of the nonprint 

media, if known (e.g. 3 3/4 ips, 33 1/2 rpm. 

and Standard Play (SP) for video tape). 

OK Cancel 

Figure 49. Block 41 Playback Speed 

Click on the OK button to continue filling in the form. 
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Block 42: Video 
Select either "Yes" or "No", indicating if video is present, in the nonprint product into BLOCK 42 (Figure 
50). 

BLOCK 42: VIDEO 

Block 42. Video 

Indicate the presence of video on the 

multi-media product. 

^IVesI 
■'.'...:   G::-NO. ■:-■' 

OK 
;— 

Cancel 

Figure 50. Block 42 Video 

Click OK to continue entering information. 

Block 43: Text 
Select either "Yes" or "No", indicating if text is present, in the nonprint product into BLOCK 43 (Figure 
51). 

BLOCK 43:  TEXT 

Block 43.  Text 

Indicate the presence of text on the 
multimedia product. 

O No 

OK Cancel 

Figure 51. Block 43 Video 

Click OK to continue entering information. 
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Block 44: Still Photos 
Select either "Yes" or "No", indicating if still photos are present, in the nonprint product into BLOCK 44 
(Figure 52). 

BLOCK 44:   STILL PHOTOS 

i Block 44.  Still Photos-  ;  

Indicate the presence of still photos on the 

multi-media product. 

CsMYesi 

'     O No 

OK Cancel 

Figure 52. Block 44 Text 

Click OK to continue entering information. 

Block 45: Audio 
Select either "Yes" or "No", indicating if audio is present, in the nonprint product into BLOCK 45 (Figure 
53). 

BLOCK 45:  AUDIO 

Block 45. Audio 

Indicate the presence of audio on the 

multi-media product. 

"■:#|Ye£ •' 

6 No 

OK Cancel 

Figure 53. Block 45 Audio 

Click OK to continue entering information. 
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BLOCK 46: Other 
Enter any other information, for which there is not an applicable block, about the nonprint product into 
BLOCK 46 (Figure 54). 

BLOCK 4G:   OTHER 

•Block 46.. Other—————^ 

Use this block to indicate any other information 

for which there is not an applicable block. 

Figure 54. Block 46 Other 

Click OK to continue entering information. 

BLOCK 47: Documentation/Supplemental Information 
List documentation required accompanying the nonprint product, such as an associated user's manual, into 
BLOCK 47 (Figure 55). 

BLOCK 47.   DOCUMENTATION/SUPPLEMENTAL INFORMATION 

-Block 47. Documentation/Supplemental Information————r-—r—^— 

List documentation required to accompany the nonprint product being 
submitted, such as an associated user manual also submitted. 
Include the medium of the documentation (papercopy, disk) and availability. 

OK Cancel 

Figure 55. Block 47 Documentation/Supplemental Information 

Click OK to continue entering information. 
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BLOCK 48: Point of Contact Name and Telephone Number 
Enter a point of contact name and a telephone number for the person who can provide additional 
information about the nonprint product in BLOCK 48 (Figure 56). Complete the telephone number field 
with no more than fourteen characters, including hyphens and parentheses. 

NOTE: It is mandatory that you enter a name and a telephone number in their appropriate fields. If there is 
no entry in the name or telephone number field, an error message appears asking you to complete these 
fields. After entering the name and number, pressing OK will allow you to complete the form.  

BLOCK 48:  POINT OF CONTACT AND TELEPHONE NUMBER 

irBlock 48. Point of Contact and Telephone Number       

List the name, address, phone number, and e-mail address of a person 

who can provide additional information about the nonprint product being 

submitted In some cases, you might have two people listed: onePOC 

for subject/content; one for media/technical questions. 

Name 

Address 

Telehone Number 

E-Mail Address 

OK Cancel 

Figure 56. Block 48 Point of Contact and Telephone Number 

SECURITY CLASSIFICATION OF THE PAGE 
The footer of this form are automatically entered, as determined by what security classifications are selected 
in the following blocks: 

a. Title Classification selection (Block 11) 
b. Classification of Product (Block 23) 
c. Classification of Abstract (Block 28) 
d. Classification of Subject Terms (Block 30a) 

The highest classification selected appears in this entry on both pages of the form. 
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ABSTRACT ENTRY MESSAGE 
The last screen that appears in the Electronic Form 530 document is a message screen indicating that you 
may now enter your abstract into Form 530 (Figure 57). 

BLOCK 27 

•Block 27. Abstract  

Include a brief (Maximum 200 words) factual summary of the most 
significant information contained in the report. 

While you may also edit other portions of the document at this time, 
modifications outside of the abstract should be kept to a minimum. 

iOfv! 

Figure 57. Abstract Entry Message 

Once you press OK from this screen, you may begin to enter your abstract. 
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The Basics of Writing the Abstract 

Writing the Abstract 
All abstracts must be under 200 words in length and may not include graphics, tables, art, charts, or 
equations. You may use the button bar and menu options to provide formatting to the abstract, such as 
Superscripts, Subscripts, justification, and indents. 

Using the Button Bar 
As you write the abstract about the nonprint product into Form 530, you may use formatting features from 
the menus and button bar. The button bar (Figure 58) has been customized, displaying all the buttons 
necessary to perform specific functions in the template. 

DjoprLfl M\MV\ JtL%lH!;$ ■Ol ▼ c* h" IF jy ion* :_»j■■[k?i 

Abstract .TJ    Subl Sup] 

Figure 58. Button Bar 

Descriptions of each button is below. 

Button 

ET 
LSI 

■si 

Function 
Start a new file. This will start a new file based off of the NORMAL template in Word 
6.0 or 7.0. 
Open a file. This is the same action as choosing Open from the File menu. 

Save a file. This is the same action as choosing Save As from the File menu. The default 
for saving these files is to save them as Rich Text Format (RTF). To do this, choosing to 
save automatically invokes the "Save As" dialog. 

■XI 

In) 

IS 

M 

Print a file. This is the same action as choosing Print from the File menu. 

This button will activate Word's Print Preview feature, allowing you to view what will 
print. This is the same action as choosing Print Preview from the File menu. 

This button will run the Word spell checker. This is the same action as choosing 
Spelling from the Tools menu. 

Cuts selected text from the file to the clipboard. This is the same action as choosing Cut 
from the Edit menu. 

Copies selected text from the file to the clipboard. This is the same action as choosing 
Copy from the Edit menu. 

Pastes cut or copied text from the clipboard into the current document at the position of 
the cursor. This is the same action as choosing Paste from the Edit menu. 

Undo a previous action. This is the same action as choosing Undo from the Edit menu. 
ONLY use this button when entering the abstract. 

Redo a previous action. This is the same action as choosing Redo from the Edit menu. 
ONLY use this button when entering the abstract. 
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IJJ 
■Ml 

J1002 '"[±j 

[Subj 

jiupj 

Toggles Paragraph marks on and off in the document. 

Inserts a symbol into the document at the position of the cursor. This is the same action 
as choosing Symbol from the Insert menu. ONLY use this button when entering the 
abstract. 
Allows you to view the document at different percentages-zoom in and out. This is the 
same action as choosing Zoom from the View menu. 

Provides Word Help on any part of the screen you click on after clicking on this button. 

Allows you to see the Form 530 style that is active on the text where your cursor is 
located. 

Selecting text, then clicking on this button will make the selected text subscripted. 
ONLY use this button when entering the abstract. 
Selecting text, then clicking on this button will make the selected text superscripted. 
ONLY use this button when entering the abstract. 
These buttons indicate the justification of the text in a cell. 

Using these buttons will allow you to indent text. ONLY use these buttons when 
entering the abstract. 
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Editing and Saving Form 530 

Editing Form 530 
Once you have completed filling out the form with the prompt screens, you will be able to edit the form as a 
normal Word 6.0 or 7.0 document. You can select text, copy text, and type over text, fixing any error 
entries when you filled in the information in the prompt screens. 

Saving Form 530 
After filling out Form 530, you will want to save the form document for submittal to the Defense Technical 
Information Center (DTIC) along with your nonprint product. To save the document, click on the SAVE AS 

button on the button bar ( 
(Figure 59) will appear. 

y I) or choose Save As from the File menu. A window similar to that below 

Save As 

FileHame: 

psfifflr 
Directories: 

c: \msof f ice\ winword 

busneeds.doc 
dialog Jon 
gr_ant.lex 
gram.dll 
hf en. lex 
hfph..clll 
fiacrode.eae 
txtwlyt.cnv 
wdreadme.hip 
iwnword.exe 
winword. hip 
wir.word opt 

Save File as Type: 

p^ msoffice 

Sr winword 
f*H letters 
I""] macros 

Q startup 
I"*! template 
[°~l wordcbt 

Drives: 

OK 

Cancel 

Options... 

Network. 

Help 

Rich Text Format 

Figure 59. "Save As " Window 

You will notice that the document is being saved as "Rich Text Format" by default. DTIC requires all 
electronic forms and documents in this format when saving. Type in the name you want to call the 
completed Form 530 and choose the directory and/or drive in which to save. Click on OK to save the 
document. 

After saving the electronic Form 530, send the electronic copies to DTIC for processing and cataloguing. 
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